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Chapter 1 Installation 
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Hardware 

 

The TravelLogic series or the PKLA1616+: 

Connect the device with the PC. (USB port) 

Insert the driver installation disc when the Windows OS detects the device. 

 

The LA2164P-2M with the PCI interface: 

 

Open the PC case. 

Insert the PCI interface card into the PCI bus of the PC. 

Insert the device mainframe into the 5.25" floppy disk slot of the PC. 

 

Connect the PCI interface card with the Data Port of the device. (PCI cable) 

Plug the PC power connector (5V, 12V) into the power connector of the device. (4PDC-Jack 

cable) 
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The LA2164P-2M with the USB interface or the printer port interface: 

Connect the device with the PC (printer round cable or USB2Printer cable). 

Plug the power adapter into the LA power connector. 

(For USB interface) Insert the driver disc for installation when the Windows OS detects the 

device. 

(For Parallel interface) The parallel configuration is EPP mode in the BIOS setting. 

External Interface for the Pocket-LA/TravelLogic 

Connect the PC with the device. (USB port) 

Insert the driver disc for installation when the Windows OS detects the device. 
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Software 

 

Insert the software disc into the CD-ROM drive. 

Run Setup.exe. 
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Driver 

 

The driver setup for different combinations of the interface and Microsoft Windows OS is: 

The printer port interface + Windows XP/ Vista/ 7/ 8: 

Run the software setup but the driver setup is needed. 

The PCI/USB interface + Windows XP/ Vista/ 7/ 8:  

Follow step a-j below, 

a. Turn on the PC after the hardware installation. 

b. Insert the installation disk into the CD-ROM drive. 

c. Double click "Add/Remove Hardware" in the Control Panel. 

d. Choose "Add a Device", the Windows OS will check the PC's hardware device. 

e. If there is no available hardware device, please select "Add a new device". 

f. Choose "Display all devices" under Windows XP etc. 

g. Click "Have Disk…". 

h. Choose "Acute EPP & ISA Interface Driver" from the installation disk. 

i. You will find the "Acute PC-based Instrument" item in the Device Manager. 

j. If you still can’t set up the driver, please check the FAQ on our web site at 

www.acute.com.tw. 

 

 

 

http://www.acute.com.tw/
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Accessories 

 

Connect the signal (A, B, C and D) to the LA2164P-2M ports A, B, C and D. 

Connect the signal cable (16 pins) and the ground cable (2 pins) to each signal pod. 

Connect the probes to the signal cable and the ground cable. 

Connect the probes to the subject under test (the ground probes must be connected to the 

ground of the subject under test).  
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Chapter 2 Operations 
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Window 

 

Timing Analysis: 

 

 

1. Toolbar 

2. Time division 

3. Acquired time  

4. Label Field 

5. Channel Field 

6. Value Field 

7. Activity Field 

8. One Level Trigger Field 

9. Quick Repetitive Run 

10. Trigger position 

11. Sample Rate 

12. Time indicator 

13. Acquire Status 

14. Vertical Scroll bar 
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15. Waveform 

16. Horizontal Scroll bar 

17. Zoom Window 

18. Timestamp / Sample 

19. Selected channel 

20. All channel 

21. Transition number of all 

channel 

22. Data measurement 

23. Bus decoder 

24. Choose bus 

25. Report toolbar 

26. Cursor position 

27. Status Field 

28. Field Splitter 

29. Report Window 

30. Update 

31. Cursor Button 

32. Frequency/ Timing/ Sample 

Clocks Switch 

33. Frequency/ Time 
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State Analysis: 
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Mark the invalid waveform 

 

If the Pre-Trigger is not enabled, then the waveform before the trigger cursor is invalid will 

be marked as dots. 

 

If the logic analyzer is stopped when capturing data, then the waveform on the right of the 

waveform window is invalid and will be marked as dots. 
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Other 

 

Create Bus(Signal) Wizard 

Click Create Bus (Signal) Wizard button ( ) on Toolbar to show the dialog box below.  

 

 

Select Command Set 

Select Command Set ( ) is for the state analysis but not a default button on the Toolbar 

menu.  
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Add Select Command Set button from Toolbar → Toolbar Buttons and click it to show the 

dialog box below; there are 4 quick settings - add command set (Add Cmd Set), delete 

command set (Del Cmd Set), add command (Add Cmd) and delete command (Del Cmd). The 

command set must be saved as *.CMS, similar to the Windows Excel file *.CSV, so you can 

edit the command set in Windows Excel and load it into the LA Viewer. 

 

A command set has three fields: 

Name: The command name that must be exclusive. 

Condition: A command has up to 3 conditions, where each condition has its own label and 

value.  

 

Description: The constant or variable in the Description field will be shown in the State 



  

 6 Acute Technology Inc. Copyright 2016 

analysis on the Waveform Window when the command conditions are met. A variable 

contains a label name within the bracket {} or will be seen as a constant; also, the label name 

must be a label name in the current project or will be shown as "***". One command can 

have three variables at most. 

 

Add Command 

Only decimal (xxx), hexadecimal (xxxh), octal (xxxo), or binary (xxxb) values can be entered 

in the value columns (Value 1 ~ 3). 

 

 

Time/State Switch 

The Time/State Switch button ( ) is a switch between the timing analysis and the state 

analysis shown on the Waveform Window. 

 

Thumb Track Scroll 

The Thumb Track Scroll button ( ) is to drag the horizontal scroll bar and the waveforms 

simultaneously. If disabled, the waveforms only move until you stop dragging the horizontal 

scroll bar. 

 

Measure Frequency, Timing or Sample Clocks 

You may check the frequency, timing, or sample clocks between any two cursors on the 
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Waveform Window as the three windows below. There are three display fields at the bottom 

of each window; the switch button ( ) on the lower-right corner of each window is to 

switch among frequency, timing, or sample clocks. 

Frequency: 

 

Timing: 

 

Sample Clocks: 

 

Click any cursor button to display the cursor menu below to choose any two buttons to 

measure the frequency, timing, or sample clocks between them. 
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Zoom In/Zoom Out 

There are several ways to zoom in and/or zoom out: 

Click Waveform →, click Zoom In/Zoom Out. 

Zoom In or Zoom Out toolbar buttons. 

Press +/- on the keyboard to zoom in/zoom out. 

Scroll the mouse wheel on the waveforms to zoom in/zoom out. 

Right-click on the waveforms and click Zoom Area to zoom in. 

 

Waveform Window 

Drag or flick the waveforms. 

Measure the time between two waveform edges: Press Ctrl + drag the mouse between two 

waveform edges to show the time between them. 

 

Scroll the mouse wheel to zoom in/out waveforms centered on the mouse cursor. 

Right-click and drag the selected waveforms to see the number of transition, time interval, 

and frequency between the two waveform edges. 

Zoom Area will display on the lower-right corner of the selected waveforms; click Zoom 
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Area to zoom in the selected waveforms. 

 

 

Report Window 

Right-click the Report Window to show the menu below.  

 

 

Find 

Find data in the Report Window; click Find to set more parameters in the Find Report dialog 

box below. 

 

Match Whole Word Only: Match all characters in Find What. 
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Match Case: "A" and "a" represent different characters in Find What. 

Direction: Find the previous/next-matched data.  

Find in Column "XX" 

Find data in a certain column. 

Find Next 

Find the next-matched data. 

Fit Header to Data 

Adjust the column width according to the data width. 

Fit Header to Name 

Adjust the column width according to its name width. 

Report All Signals 

Display all data except bus decode in the Report Window. 

Report Selected Signals 

Display the selected data in the Report Window. 

Report Transitions 

Display the transitions and rising edges and falling edges in the Report Window. 

Report Data Measurement 

Display the channel measurement in the Report Window. 

Report ( ) 

Display the bus decode data in the Report Window. 

Close Report 

Close the Report Window. 

Save report to file 

Save the report as a file. 

Show the timing in the Waveform Window 

Click the Show the timing in the Waveform Window button ( ) to show the time between 

waveform transitions in the Waveform Window. 
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Shade Alternate Channels 

Click the Shade Alternate Channels button ( ) to shade alternate channels with 2 different 

colors to better view the waveforms. 

 

Modify the label name 

Click the Label Name for 1 second to modify the label name. 

 

Generate a Bitmap File 

Click the Generate a Bitmap File button ( ) to save the waveforms in format like PNG, 

JPG, GIF, BMP, or TIFF. 

Copy to clipboard 

Click the Copy to clipboard button ( ) to copy the waveforms to the clipboard. 
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Auxiliary 

 

Auxiliary Label Menu 

Right-click the label field to show the auxiliary label menu 

below. 

Undo: Undo the previous changes on labels. 

Add A Signal: Create a channel. 

Add Group(Bus): Create group channels (bus). 

Add Bus Decode: Create a bus decode channel. 

Add All Labels: Create all channels. The "Delete the current 

labels?" dialog box will show, if click yes, the exiting labels 

will be deleted. 

 

Delete Unused: Delete the unused (shaded) labels. 

Delete Selected: Delete the selected label. Right-click the selected label to delete or click the 

selected label and press the Delete key. 

Delete All Label: Delete all labels. 

Modify Name: Modify the label name. Any label name must be exclusive with no more than 

31 characters including symbols like [,], _, -, !, ~, and are case sensitive. 

Configure: Configure the labels. 
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Combine: 

 

Combine the selected labels to form a group channels (bus). Select labels in Source 

(Destination) and click → (←) to add (remove) labels to (from) the group. 

 

Arrange: 

  

Arrange the order of all labels in a group channels (bus). 

 

Decompose: Right-click the group channels (bus) to decompose into individual labels with 

new names. 

Sort: Sort all labels in alphabetical order. 



  

 14 Acute Technology Inc. Copyright 2016 

Activity Auxiliary 

Right-click the Activity Field to show the menu below.  

 

Activity: Show the state of the selected channel. 

Activity freq. in CH-X: Show the frequency of the selected channel and one channel ONLY. 
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Simple Trigger Auxiliary 

Right-click any Trigger field to show one of the two menus below to set the trigger: 

Signal 

 

Only one trigger (channel) can be set as Rising Edge ↑, Falling Edge ↓ or Change ↕. 

Group 

 

Only five types of codes can be entered:  

Hexadecimal code (nnh), e.g. 3Ah. 

Octal code (nno), e.g. 57o. 

Binary code (nnb), e.g. 110010b. 

ASCII code ('X'), e.g. 'A'. 

Decimal code (nn), e.g. 35. 

Blank cancel settings. 
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Bus 

 

Right-click the Trigger button to show the menu below. 

 

 

Clear Trigger Setting: Clear the trigger settings. 

Close: Close the Trigger field. 



  

 17 Acute Technology Inc. Copyright 2016 

Easy Start 

 

Follow the steps below to easily run the LA Viewer. 

a. Execute the LA Viewer programs ( ).  

b. Click the Threshold Settings button ( ) to set the threshold voltages 

according to the target system signals. 

c. Right-click the label field to show the label menu. 

d. Set up labels with names, channel numbers, and colors. The label name must be no more 

than 31 characters that can be text, numbers, or symbols. 

e. Click the Hardware Settings button ( ) to set the sampling rate 

which ideally should be 5-10 times of the frequency of the target signal. 

a. Click the Trigger Settings button ( ) to set up trigger conditions. 

b. Connect the instrument's ground lines to the grounds of the target system. 

c. Connect the grippers to the target system according to the defined label names. 

d. If you want to measure the state, select External (synchronizing) from the Hardware 

Settings ( ) and connect the clock channel to the target system as 

the clock source, then click the Time/State Switch button ( ) to the state analysis on 

the Waveform Window. 

e. Move the trigger cursor (T) to the Waveform Window. 

f. Click the Acquire Data button ( ). 
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Cursors 

 

There are 26 (A~Z) cursors available, but only 6 cursors (T, A, B, C, D, E) are shown on the 

Waveform Window by default. 

Click the Add Cursor/Delete Cursor button ( / ) to add/delete cursors or press Shift + 

key to add the cursor. 

 

There are several ways to move cursors in the Waveform Window. 

Drag the cursor tag. 

Drag the cursor. 

Use  or  (↑or ↓) to move the cursor in the timing (state) window. 

Press A - Z to display cursor A-Z in the center of the Waveform Window. 

Press Shift + A-Z to move cursor A-Z to the mouse cursor.  

Press Ctrl + drag any cursor except cursor E to move two cursors (any dragged cursor and 

cursor E) together. The default of the tracking cursor is cursor E. You can also change the 

tracking cursor in the System Environments, to set the tracking cursor specified with A-E. 
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Field Adjustment 

 

Move the field splitter to adjust the size of any field (Label, Channel, Value, Activity, Simple 

Trigger in timing analysis, or Channel, Comment in state analysis) or the Waveform 

Window. 
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Hot Key Definition 

 
 Items Hot Key 

1. 
Display the waveform window 

centered on cursor A - Z 
A-Z 

2. 
Display cursor A ~ Z at the mouse 

cursor position 
Shift+A-Z 

3. Zoom In + 

4. Zoom Out - 

5. Find Report Ctrl+F 

6. Hardware Settings  Ctrl+H 

7. Search Next Pattern Ctrl+N 

8. Print Waveform Ctrl+P 

9. Search Pattern Ctrl+S 

10. Trigger Settings Ctrl+T 

11. Threshold Settings Ctrl+V 

12. Undo Alt+BackSpace 

13. Delete Labels Delete 

14. Stop Acquisition Escape 

15. Find Next Report F3 

16. Run Enter 

17. Repetitive Run Ctrl+Enter 

18. System Environments Alt+Enter 

19. 
Frequency, Timing or Sample Clocks 

Switch 
Space 

20. Zoom In/Zoom Out Mouse Wheel (Waveform Window) 

21. Moves data up or down Mouse Wheel (Report Window) 

22. Move labels up or down Mouse Wheel (Label Field) 

23. Measure Waveforms Ctrl+Drag Mouse (Waveform Window) 

24. Drag Waveforms Drag the Mouse (Waveform Window) 

25. Measure and Zoom Waveforms Right-drag the Mouse (Waveform Window) 
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Data Storage 

 

There are three ways to store the captured data: 1.Conventional, 2.Transitional and 

3.Qualified. 

 

Conventional Storage 

This is the most common way to store the captured data, 1 bit by bit, and the logic analyzer 

will stop when its memory buffer is full. 

 

Transitional Storage 

The logic analyzer will only store the transitional data (rising or falling) and record the time 

duration of the non-transitional data which is also called Timestamp. Only the TravelLogic 

series supports the transitional storage.  

 

Features 

Long Duration 

The logic analyzer only record the transitional data, so the recorded time can be long duration 

as long as the data is not in transition. 

32 Channels available 

32 channels are available for the transitional storage. 8 channels and 32 channels of 

transitional storage are available for the series of TL2x36, but the series of TL2x18 only 

support 8 channels of transitional storage. 

Captured data will not be lost even interrupted 

The captured data will not be lost even when the logic analyzer is stopped when capturing 

data. 
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Display the used memory buffer 

The LA Viewer will display the percentage of the memory buffer is being used. 

How to use the Transitional Storage 

Click Hardware Settings ( ) on Toolbar (or Device menu) to show the 

Hardware Settings dialog box below. 

 

Quick tips: 

If there many transitions in the captured data, then do NOT use the Transitional Storage. 

The maximum memory buffer will be set as default, not available for change. Also, only the 

transitional data of the channels on the LA Viewer window can be stored. 

The LA Viewer will set the trigger position in percentage, which means the data after the 

trigger position as a percentile of the total captured data. The trigger cursor can’t be input 

(moved) on the waveform window as the conventional storage. 

The Pre-Trigger is not available for the Transitional Storage. 

 

Qualified Storage 
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The Qualified Storage is only available for the Transitional Storage. It works as a filter to 

store data (in read or write status) in the Transitional Storage to further expand the efficiency 

of the memory buffer. The Qualified Storage is only available for the TravelLogic series. 

 

Features 

Save/Don’t Save qualified data 

You may set conditions to save or not to save the qualified data. 

Available for multi channels or the bus decodes. 

Multi-conditions 

Conditions can be 1, 0, rising, falling, or transition. 

Continuous time 

The time of the waveform of the qualified storage is continuous. 

 

Qualified Storage Settings 
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Disable Qualified storage 

The Qualified storage is disabled when the column checked. 

Parameter 

Double click on Value to show the conditions (rising, falling, or transition). 

Save/Don’t Save 

Click to save or don’t save the qualified data. 

Store edge 

Store the edges. 
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Using External Clock to analysis state synchronizing  

 

Click Hardware Settings ( ) on Toolbar (or Device menu) to show the 

Hardware Settings dialog box below. 

 

 

Ext. Clock Channel 

Select External-36 where "-36" means 36 channels and select channels from Ext. Clock 

Channel on the upper-right corner of this dialog box. 

 

CH35: ONLY the last channel (CH35) can be set as the external clock channel for the 

selected External-36. 

!CH35: Invert the waveform of CH35. 
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CH34 & CH35: Both CH34 and CH35 together serve as the clock qualifier to qualify what 

data should be acquired. 

CH34 | CH35: Either CH34 or CH35 serves as the clock qualifier to qualify what data should 

be acquired. 

Ext. Clock(Hz): Set the external clock speed (1000000 Hz e.g.) on the lower-left corner 

of this dialog box. 
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Chapter 3 Functionality 
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File 

 

Open Waveform File 

Load a waveform file (*.law). Waveform files can also be opened when dragged to the 

waveform field  

Save Waveform 

  

Format: You can save the acquired data in four different formats: 

Format Type 

*.law to be used by the LA Viewer. a. LAW 3.0 Wave File. 

*.pgw to be used by the PG Editor for 

the Acute digital pattern generator. 
a. PGW 1.0 Wave File 

*.txt to be saved as a text file. 

a. Transitional Text File (.txt) 

Normal Compression. 

b. Text File (.txt) 

No Compression. 

c. Include File Header: save the parameter in 

the file header. 

*.VCD to be saved as a Value Change 

Dump file. 
a. .VCD File (.VCD) 
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File Name: Enter an exclusive file name or press Browse. 

Range: Select the range of the waveforms to be saved. 

Channel: Channels to be saved. 

 

Manage Project 

 

Project List 

The project list displays current projects that contain label names, trigger parameters and 

threshold settings etc. Right-click the project name to show the menu below. 

 

Load: Load a project from the Project List. 

Delete: Delete a project in the Project List. 

Rename: Rename a project in the Project List. 

Properties: Show the contents of a project. 

Add Project: Create a new project. 
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Load Last Project 

The LA Viewer, when exited, will automatically save the current working environments as a 

project file. You can load this project file next time when start the LA Viewer. 

 

Print Waveform 

 

Printer Device: Select a printer in Printer Device. 

Fit one paper ( ): The height and width of the selected waveforms will be printed as 

those of a page. 

Horizontal ( ): The width of the selected waveforms will be printed as that of a page. 

Vertical ( ): The height of the selected waveforms will be printed as that of a page. 

Custom Size ( ): The selected waveforms will be printed in the customized height and 

width. 

Grid Size: Grid size is adjustable, but not available for printing the state data.  

Color (Gray scale): Print the selected waveforms in their original (gray) colors for color 

(non-color) printers; the background is always white color for all printers. 
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Omit Ch. width setting: This function is only available for printing the State data and will 

cut the length of label names to the same as that of the State data in order to print as many 

data in one page. 

Range: From Start point of the range To End point of the range. 

Channel: Print the selected channels. 

 

Import  

(only available in TL2236B+) 

Translate the digital or analog text file into .law format from the other device. 

 

Agilent LA Moduled CSV text file: The file export from Module CSV text file.  

 

Tektronix TLA Data Exchange Format: The file must save as the TLA Data Exchange 

Format. 
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LA Text File: The first column will be the label name.  

 

 

DSO Text File:  

Support import multi files and setting individually. LA software will check over the sample 

rate/sample interval and trigger position of the first ten column 

The unit value setting: If the unit is mV, 1357 will express as 1.357V. If the unit is uV, 

135790 will express as 0.13579V. 

When import differential signal, the settings between the two channels must be the same 

settings. 
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Other Text File: User edit its waveform data and it should reference the data format in the 

figure. 

 

It supports single-line comments preceded by two forward slashes (//). 
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Label 

 

Add A Signal 

Click Add A Signal to show the dialog box below.  

 

Label Name: Enter the label name with no more than 31 characters. (Chinese word 

expresses two characters.) 

Channel Number: Set the channel number. 

Color: Set the waveform color. 

Invert: Invert the waveforms. 

 

Group(Bus) 

Click on Add Group (Bus) to show the Add group (bus) dialog below. 
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Label Name: Enter the label name for the group (bus) with no more than 31 characters. 

(Chinese word expresses two characters.) 

Auto Increment: Set group channels between Start and End channels on numeric order. 

User Defined 

# of Channels: Set the group (bus) channels in the dialog box below. 

Group Channel List: 

 

Set each channel as Add A Signal. 

Color: Set the waveform color. 

Value Type: Set the value type in HEX (hexadecimal), DEC (decimal), OCT (Octal), BIN 

(Binary), ASC (ASCII), Analog (2's comp. (complement)), Value (2’s comp. (complement)).  

Invert: Invert the waveforms. 

Gray Code: Show the waveforms in Gray code. 

 

Bus Decode 

Click on Add Bus Decode to show the dialog box below. 
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Bus Name: Enter the label name with no more than 31 characters. (Chinese word expresses 

two characters.) 

Color: Set the waveform color. 

Display the waveforms with decode: Display the waveforms with its decode together. 

 

Advance: Set the decode parameters or press OK to use default settings. 
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Label Settings 

 

Label Name: Enter the label name with no more than 31 characters. (Chinese word expresses 

two characters.)  

Channel Number: Set the channel number. 

Value Type: Set the value type in HEX (hexadecimal), DEC (decimal), OCT (Octal), BIN 

(Binary), ASC (ASCII), Analog (2's comp. (complement)), Value (2’comp (complement)). 

Color: Set the waveform color. 

Invert: Invert the waveforms. 

Gray Code: Show the waveforms in Gray code. 

Display the waveforms with decode: Display the waveforms with its decode together. 

Advance: Set the decode parameters or press OK to use default settings. 
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Add All Labels 

Create all new channels. The "Delete the current labels?" dialog box will show, if click yes, 

the exiting labels will be deleted. 

 

 

Delete All Labels 

Delete all labels. 

 

Import Labels 

You may edit the label names in a .CSV file and import the file into the LA Viewer. 

Ex1: edit in an Excel file 

Bus 0..7 

data 3 

NAND 9,10,11,12,13,14,15,16,19,20,18,21,24,23 

Bus2 1 3 5 7 9 

Ex2: edit by an editor 

Bus,0..7 

data,3  

NAND,"9,10,11,12,13,14,15,16,19,20,18,21,24,23" 

Bus2,1,3,5,7,9 

Result: 
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The first column is the Label name, which can be in English characters or with alphabetic 

numbers; the second column is the Channel number which can be “0..7” to represent a bus 

form channel 0 to channel 7 or in a number “2” to represent the channel 2. 
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Waveform 

 

Zoom ALL 

Display all waveforms in the Waveform Window.  

Zoom 1:1 

One sample is shown as one point on the Waveform Window. 

Zoom In 

Zoom in the waveforms centered on the mouse cursor. 

Zoom Out 

Zoom out the waveforms centered on the mouse cursor. 

Find Trigger Marker (T) 

Display the trigger cursor as the center of the Waveform Window. Click Find Trigger Marker 

or press T. 

Find Cursor A, B, C, D, E 

Display cursor A-E as the center of the Waveform Window. Click Find Cursor A~E or press 

A-E. 

Generate a Bitmap File 

Save the waveforms in format like PNG, JPG, GIF, BMP, or TIFF. 

Copy to clipboard 

Copy the waveforms to the clipboard. 

Invert Waveform 

Invert the waveform. Click the Invert Waveform button ( ) on Toolbar. 

Search Pattern 

The LA Viewer can search two kinds of acquired data: 1. Pattern, 2. Decode. Click the 

Search Pattern button ( ) to search the acquired data in the same pattern or decode.  
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Pattern 

Add: Select a label (or group) and its value 0, 1, ↑ or ↓ (Hex). 

Load Trigger Settings: Load the trigger settings. 

Clear Pattern Settings: Clear all pattern settings. 

Range: The range within the acquired data you want to search for the same pattern. 

Pass Count: Pass Count will pass N times that triggers occurred. 

Result: Click Search to run Search Pattern and the LA Viewer will show the number of 

matches on the Status field below or "Cannot find the specified waveform!" if no matches; 

Cursor B will show on the first matched data 
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Decode (Bus Decode)  

 

Select Decode: Label Select a label name. 

Pattern: Pattern must be ASCII characters. 

Match Whole Word Only: All characters in Pattern must be met. 

Match Case: "A" and "a" represent different characters. 

Range: The range within the acquired data you want to search for the same pattern. 
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Pass Count: Pass Count will pass N times that triggers occurred. 

Result: Click Search to run Search Bus Decode and the LA Viewer will show the number of 

matches on the Status field below or "Can not find the specified waveform!" if no matches; 

Cursor B will show on the first matched decode. 

 

 

 

Search Previous / Next Pattern 

Click the Search Previous / Next Pattern button (  / ) to search the previous / next 

matched pattern starting from Cursor B. The Pass Count function is not available in Search 

Next 

 

Go to Report Window 

Click the Go to Report Window button ( ) to show the data of the waveforms on the 

Report Window. 

 

Compare Waveforms 

Click Compare Waveforms in the Waveform menu or push F8, you will see the Compare 

Waveforms dialog box as below. 
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Default – it stores the waveforms on the Waveform Window by default. 

Reference – it stores the waveforms to be compared to. 

Temp. 1 ~ Temp. 6 store another 6 temporary reference waveforms. 

All 8 waveforms can be moved. 

 

Click Compare to see the Default waveforms (in white color) and the Reference waveforms 
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(in red color) below.  

 

There are three ways to compare these two waveforms: 

Drag the Default waveforms only - drag the white waveforms. 

Drag the Reference waveforms - hold down the Ctrl key and drag the red waveforms. 

Drag the two waveforms together - hold down the Shift key and drag the two waveforms. 

F9 is the hotkey to compare two waveforms if the Default and Reference waveforms already 

exist. 

 

You can also compare two waveform files (Test1.law and Test2.law e.g.). Open the first 

waveform file (Test1.law) as below. 
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Then push F8 to show the Compare Waveforms dialog box below with the Test1 file as the 

Default waveform. 

Drag the Default waveforms to the Reference below. 

 

Then click Compare to return to the LA Viewer window and open the second waveform file 

(Test2.law), you will see the Test1 as the Reference waveforms and the Test2 file as the 

Default waveforms.  

There are three ways to compare the two waveforms: 

Drag the Default waveforms: drag the white waveforms. 

Drag the Reference waveforms: hold down the Ctrl key and drag the red waveforms. 

Drag the two waveforms together: hold down the Shift key and drag the two 

waveforms. 
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Data Measurement 

Cli 

Add the measurement by the label/type/range on the Report Window. 

You can drag exit measurement item in the dialog to add the same item. 

Type Channels 

Period 1 

Frequency 1 

Edge Count 1 

Cycle Count 1 

Positive Cycle Count 1 

Negative Cycle Count 1 

Positive Pulse count 1 

Negative Pulse count 1 

Positive Pulse Width 1 

Negative Pulse Count 1 

Channel-to-Channel Rising Delay 2 

Channel-to-Channel Falling Delay 2 

Channel Rising to Channel Falling Delay 2 

Channel Falling to Channel Rising Delay 2 

Phase Delay 2 
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Result: Click the report icon to check the measurement result. 

 

 

Waveform Properties 

Click Waveform Properties to display all parameters' settings saved by default for the last 

data acquisition. 
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View 

 

Toolbar 

Display all the buttons below. 

Right click the mouse to change the size of tool bar.  

 

 

Channel 

Display the selected labels' channel numbers below. 

 

The channel name will be displayed if “Display the waveform with decode” is checked when 

adding a bus decode.  

 

 

Value 

 

Display the selected labels' value below. 
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Activity 

Display the channels' activities (frequency or state) below. 

 

 

Simple Trigger 

Display the selected channels' trigger settings below. 

 

 

Zoom Window 

Display the acquired waveforms of the top 4 channels or the selected channel in the Zoom 

Window to pan the same waveforms on the Waveform Window. 
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These 4 labels MUST be the top 4 labels in the label field. 

The transparent area in the Zoom Window denotes its position in and relative size of the 

entire waveforms. Move or Zoom the transparent area by mouse will move or zoom the 

waveforms in the Waveform Window. Click in the Waveform Window to move the 

transparent area.  

There will be a red bar on the top and bottom of the transparent area when it is too small to 

see. 

The Selected Label 

Select the label you want to see in the Zoom Window; click View → Zoom Window → The 

Selected Label. 
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Report Window 

Display the labels' value. Click View → Report Window to show the menu below. Move the 

waveforms in the Waveform Window and those waveforms’ values will move accordingly in 

the Report Window. 

The cursor in the waveform window marked in the report window. There are three 

type: 

Upper triangle: In the middle of current transition and prev transition 

Triangle: In the current transition. 

Lower triangle: In the middle of current transition and next transition 
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All Labels 

Show all labels' values in the Report Window below. 
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Selected Labels 

Show the selected labels’ values in the Report Window. 

 

Transitions Labels 

Show the transitions / rising / falling number between the cursors.  
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Bus Decode shows a bus decode in the Waveform Window and the Report Window. 

 

Save report to file 

Save the report as a .CSV or text file, it can choose “No Sample/Timestamp” when save 

as .CSV file. 

 

Waveform/Report Tracking 

Dragging the waveform, the Report Window will automatically follow the movement, so that 

Waveform Window and Report Window can be displayed simultaneously. 
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Device 

 

Run 

Acquire data and fill the memory buffer when the trigger occurs and stop when the memory 

buffer is full. The running status icon ( ) on the upper-right corner of the software window 

will flash while some toolbar buttons are disabled (in gray color) during the data acquisition. 

 

Repetitive Run 

Acquire data continuously and only stop when you press the Stop Run button. 

 

Quick Repetitive Run 

Acquire data continuously and save to “work directory” until press the Stop Run button. 

 

Stop Run 

Stop acquiring data. 
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Hardware Settings 

Field Description 

Field Name Description 

Mode 

Each mode represents an independent firmware. 

a. LA1000P、LA2000P and PKLA1000 Series 

 Single 

Original memory depth per channel for all channels. 

 Double 

Double memory depth per channel for a half channels used. 

 External Clock 

Use the device-under-test’s clock as source to sample (synchronize) 

analysis. 

b. TravelLogic Series 

 PicoVu 4G/PicoVu 2G/1.6G/800M/400M/200M 

Available sampling rates (Hz). 

 PicoVu 4G Glitch 

Set the glitch as the trigger condition. 

 PicoVu 4G Transitional/Transitional Storage 

Record the transitional data only (rising or falling edge) and the 

time between two edges.  

 CAN/I
2
C/I

2
S/LPC/SPI/SVID/UART… Trigger 

Set the bus decode as the trigger condition.  

 External Clock 

Use the device-under-test’s external clock as source to sample 

(synchronize). 

Min. S/R Minimum sampling rate. 

Max. S/R Maximum sampling rate. 

Available ch. Select the number of channels to be used. 

Min. Mem. Minimum memory depth. 

Max. Mem. Maximum memory depth. 
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Ext. Clock(Hz) 

Enter the timing for the external clock when it is used as the sampling rate. 

Custom Memory Depths(bits/ch) 

Customize the memory depth per channel manually. 

Recordable Time 

The LA Viewer will calculate and display the time to record the captured data based on the 

sampling rate and custom memory depth. 
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Trigger Settings 

 

Trigger is to use the logic analyzer’s electronic circuits to capture the data that matches the 

pre-set criteria.  

 

Trigger Mode: 

Pre-Trigger 

Click Pre-Trigger to record the acquired data in the memory buffer between its beginning and 

the trigger position until full even when triggers occurred in between. 

 

Post-Trigger 

Click Post-Trigger to record the acquired data in the memory buffer between its beginning 

and the trigger position until full and then stop. 

 

Delay-Trigger 

Delay the trigger N nanoseconds (ns) after the trigger position. 

 

Pass Count 

Pass count will pass N times that triggers occurred. 

 

Common Trigger Settings: 

Select trigger 

Click Trigger Settings on Toolbar or Device menu 
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Reset 

Clear all trigger settings. 

Save/Load 

Save/Load the current triggers settings. 

 

 



  

 61 Acute Technology Inc. Copyright 2016 

Single Level Trigger 

The single level trigger is available for all logic analyzers. Settings dialog box below. 

 

Channel: (Use the channel numbers to be set.) 

Click on the channel to set its value (x is the default) as the menu below, but ONLY one 

channel can be set as Rising Edge ↑, Falling Edge ↓, or Change ↕.  

 

Label: (Use the channel name to be set.) 
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Double click or right-click on the label name, channel, or value of any single channel to set 

its value (x is the default) as the menu below, but ONLY one channel can be set as Rising 

Edge ↑, Falling Edge ↓, or Change ↕. 

 

If a label represents multi channels (8 bits e.g.), its value can be set as: 

Hexadecimal (3Ah e.g.) 

Octal (57o e.g.) 

Binary (110010b e.g.) 

Decimal (35 e.g.) 

ASCII ('A' e.g.). 
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Sequence Trigger 

This feature is only available in TravelLogic Series. Sequence Trigger Settings dialog box 

below. 

 

Sequence Trigger Settings 

The Sequence Trigger has 16 levels and the last level is the trigger; the Pre-Trigger and Pass 

Count settings are the same for all levels. For example, a 12-levels sequence trigger is set as 

the dialog box below: Next (P1, P3 ... P5, P10 and P11) means continuous trigger condition, 

Then If (P2, P6,..., P9) means discontinuous trigger condition and Then Trigger (P12) means 

trigger. 
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Sequence by the selected channel 

You may set the sequence trigger condition on your selected channel only to avoid trigger 

conditions in wanted channels. 

For instance, you can set rising signal as the trigger condition only in the Clock channel and 

ignore the rising signals in another 4 data channels. 
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Alternative Sequence Trigger 

This feature is only available in TravelLogic Series. Alternative Sequence Trigger Settings 

dialog box below. 
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Comparison Trigger 

This feature is only available in TravelLogic Series and only available at or under 200Mz, so 

you must select the 200M-36 mode in the Hardware Settings dialog box below. The 

comparison trigger is designed to compare group bus but not for the bus decode. 

 

Trigger Setting 

Comparison Trigger Settings dialog box below. 

 

Label 

Select a label with two values (Value1, Value2) for comparison. 

Value1, Value2 

The values can be up to 32 bits. Input can be in binary, decimal, hex code or don’t care. 

Comparison conditions 

The instrument will trigger when one (only) of the conditions below is matched. 

“Pattern == Value1 or Pattern == Value2”, 

“Pattern != Value1 and Pattern !=Value2”, 

“Pattern > Value1”, 

“Pattern >= Value1”, 

“Pattern < Value1”, 

“Pattern <= Value1”, 
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“Pattern >= Value1 and Pattern <= Value2” (Value2 must > Value1), 

“Pattern < Value1 or Pattern > Value2” (Value2 must > Value1). 

Chip Select Channel 

The instrument will trigger only when WR is high. 

Latch Channel 

The instrument will trigger only when CS is rising. 
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Width Trigger 

Only the TravelLogic series and the LA2164P support the width trigger. Settings dialog box 

below. 

LA2164P: 

 

TravelLogic series: 
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Pulse Width Trigger 

Pulse Width condition can be set as > (or <) N nanoseconds (ns). For example, set the Clock 

Pulse Value at 1 (high) and Pulse Width Trigger > 50 ns, the instrument will trigger when the 

clock pulse is High and its pulse width > 50 ns. 

Samples = pulse width/sampling rate. 
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Timeout Trigger 

Only the TravelLogic support the Timeout trigger in the dialog box below. 

   

Timeout Trigger 

Trigger when clock/time holds and out of the time value.  
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Glitch Trigger 

The feature glitch trigger is only available for the TravelLogic Settings dialog box below. 

 

Trigger Setting 

Select PicoVu 4G Glitch. The Glitch Trigger Settings dialog box below. 

 

ONLY Channel 0 (default) can be the glitch trigger channel. Parameter range: 0.5 ~ 8.25 

nanosecond (ns) with a 0.25 ns interval.  

Click OK to trigger the glitch and the result will show on the Waveform Window below. 

Result 
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External Trigger 

Only the TravelLogic and the PkLA1616+ support the External Trigger. 

The settings dialog box below.  

 

The TravelLogic series support all four trigger conditions: Rising Edge, Falling Edge, 

Pre-Trigger and Pass Count; the PkLA1616+ only supports Rising Edge. 

 

Trigger connection 

Connect the MCX cable to the trigger in (Trig-In) port of the logic analyzer. 

 

Delay Trigger 

The Delay trigger is only available for the  LA2164P. 

 

Trigger Setting 

Click Single level to show the Single Level Trigger Settings dialog box below. 
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Delay Trigger 

Delay the trigger N nanoseconds (ns) after the trigger position. 

Save/Load/Clear Trigger Table 

Save 

Save the trigger settings as a file with subsidiary file name *.aqt. 

Load 

Load the trigger settings file, which must fit for the trigger selected in Hardware Settings. 

Clear 

Clear the trigger settings. 
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Threshold Settings 

 

Single Threshold 

The logic analyzers use threshold voltages to determine logic levels. 

 

You can use the default threshold or customize it (User Define).  
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Set the range of +6V - -6V.Click Customize to add, modify, or delete the thresholds. 

 

 

Schmitt Circuit 
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When the target signal transits slowly and bounces, then the logic analyzer might see many 

noises as the diagram below. The Schmitt circuit offers two thresholds to prevent such noises.  

 

 

Method: 

Only available for TravelLogic and sample rates at or below 200 MHz. 

Two thresholds: Threshold-High and Threshold-Low are represented by group 1 (Channel 

0-17) and group 2 (Channel 18-35).  

Threshold setting rules 

Channel 0 and Channel 18 are a pair, Channel 1 and Channel 19 are a pair, … 

 

Group 1 (Channel 0-17) can be Threshold-High or Threshold-Low.  

When the target signal is rising, it must pass over the Threshold-High to turn to logic 1 from 

logic 0; when the target signal is falling, it must pass over the Threshold-Low to turn to logic 

0 from logic 1. 
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Threshold Settings Window 

If the Schmitt circuit is checked, then it is Schmitt trigger model. 
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Glitch Fitter Settings 

 

The TravelLogic series offers this glitch filter to filter those glitches in low speed transitions. 

This function works for all signals in front of triggers because it is a firmware filter, but only 

available for sample rates at or below 1.6 GHz. 

Trigger Setting 

Click Glitch Filter Settings on the Device menu to show the dialog box below.  

 

CH0 ~ CH35 

Check the channel(s) to be filtered. 

Reset 

Clear all settings. 

All On 

Select all channels to be filtered. 

Filter less than XX ns pulse 

Set the pulse width of the filter. 

Red Spots 

The filtered (Data Bus) channel will be marked by red spot on the upper-left corner of its 

label field.  
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Applications 

Example 1 Filter glitches caused by bouncing signals. 

Hardware 

Signal source: Tektronix AFG3252 

DSO: Tektronix MSO2024 

LA: Acute TL2236B 

Software 

Measure CH 0 with a 10ns-pulse filter and CH 1 without any filter. 

 

Result 

Click OK to run the LA Viewer and see CH00 (no glitch) and CH01 (glitches). 
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Example 2Filter glitches caused by crosstalk. 

Hardware 

Signal source: Crosstalk between circuit lines of a target system. 

DSO: Acute DS-1302  

LA: Acute TL2236B  

Software 

Measure CH 0 with a 10ns-pulse filter and CH 1 without filter. 

Result 

Click OK to run the LA Viewer and see CH00 (no glitch) and CH01 (multiple glitches). 
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Stack with the DSO 

 

The software to stack DSOs of different brands is different: 

DSO brand Software 

Acute Any Acute software CD-R (DSO software). 

Tektronix 
Please download the TEKVISA CONNECTIVITY SOFTWARE 

from the Tektronix website. 

Agilent 

Keysight 

Please download the KEYSIGHT IO LIBRARIES SUITE from the 

Keysight website. 

GW Instek 
Please download the Windows USB Drives form the GW Instek 

website. 

LeCroy Please download the NI-VISA and Drivers from the NI website. 

HAMEG Please download the NI-VISA and Drivers from the NI website. 

R & S Please download the NI-VISA and Drivers from the NI website. 
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DSOs that can be stacked: 

DSO brand Model USB TCP/IP 

Acute  DS-1000/TravelScope V  

Tektronix 

 TDS1000B/1000C/2000B/3000/3000B/3000C/ 

5000B/7000 

 DPO2000/3000/4000/4000B/5000/7000 

   7000C/70000/70000B 

 DSA70000/70000B 

 MSO2000/3000/4000/4000B/5000 

 MDO4000 

 TPS2000/2000B 

V V 

Agilent 

 DSO1000A/5000A/DSO6000A/6000L/7000A/

7000B/9000A 

 MSO6000A/7000A/7000B/9000A 

 DSO-X 4000A/MSO-X 4000A series 

 DSO-X 3000A/MSO-X 3000A series 

 DSO-X 2000A/MSO-X 2000A series 

V V 

Keysight 
 DSO-X 3000T series 

 MSO-X 3000T series 
V V 

GW Instek  GDS1000A/2000/3000 series V  

LeCroy 

 WaveRunner / WaveSurfer 

 HDO4000 / 6000 series 

 SDA 8 Zi-A / DDA 8 Zi-A series 

 V 

HAMEG  HMO3000/2000/1000 series V V 

R & S  RTO1000 series  V 

The stack diagram: 

The logic analyzer is the Master and the DSO is the Slave (Diagram 1). 
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Connect the logic analyzer (Trig-Out) with the DSO (Trig-In or Ch4 for Tektronix MDO4000 

serial) over a MCX-BNC able for the Tektronix/Agilent/GW Instek DSO (MCX-MCX cable 

for Acute DSO); connect the DSO with the PC over an USB or Ethernet cable. 

 

The DSO is the Master and the logic analyzer is the Slave (Diagram 2). 

 

 

Connect the DSO (Trig-Out) with the logic analyzer (Trig-In) over a MCX-BNC cable for the 

Tektronix/Agilent/GW Instek DSO (MCX-MCX cable for Acute DSO); connect the DSO 

with the PC over an USB or Ethernet cable. 
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Click DSO stack settings on the Device menu and see the dialog box below. 

 

Select the DSO Brand 

HAMEG, Tektronix, Agilent, Acute, LeCroy, Instek or Emulation (no DSO stacked). 

Connection Type 

USB, TCP/IP, Auto. If the DSO model is the Tektronix TDS5000B or DPO7000, use its 

built-in Windows OS to run the VXI-11 Server, then install the LA Viewer in the DSO and 

select Auto to stack. 

Connect IP 

Enter the IP address if the connection type is TCP/IP. If the stack cable is the Ethernet 

crossover cable, please set the IP addresses for the logic analyzer (192.168.1.1) and the DSO 

(192.168.1.2).  

System/Horizontal Parameters 

Settings by DSO 

It’s for the DS1000/TravelScope to the master device. 

Connection 

Display the DSO model. 
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Sampling Type 

Sampling Type can only be adjusted by but the Tektronix/Agilent /GwInstek/LeCroy  DSO: 

Maximum 

The maximum sampling rate of the DSO. 

Manual 

Set the sample rate manually, only available for the Tektronix/Agilent /GwInstek/LeCroy. 

LA X 1 

The ratio of the sample rate of the DSO and the logic analyzer is 1:1. 

LA X 10 

The ratio of the sample rate of the DSO and the logic analyzer is 10:1. 

Edit 

Set the sample rate of the DSO manually. 

The sample rate of the DSO should be set as 10 times of that of the logic analyzer 

(highly recommended).  

Sampling Rate 

Only available when the Sampling Type is “Edit”. 

Trigger Pos. Type 

Default 

The trigger position of the logic analyzer is the same position set manually for the Tektronix 

or Agilent DSO and is in the middle by default for the Acute DSO. 

Smart(Auto) 

Set the trigger position of the DSO automatically. It is only available for Tektronix 

DPO7000/7000C. 

Manual 

Set the trigger position of the DSO manually. 

Trigger Position 
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Set the DSO trigger position.1 

The memory depth of the stacked Tektronix or Agilent DSO is set manually; if the memory 

depth is set as 10Kb, then only 10Kb data will be shown in the LA Viewer. 

Stack Delay 

There will be time delay between the logic analyzer and the DSO due to stack; so, you can 

compensate the delay by entering the delay time between the two stacked instruments. There 

is time delay between the stacked DSO and logic analyzer; you can fix the delay by pressing 

the Shift key and dragging the DSO waveform on the Waveform Window. Click OK after all 

settings. 

Click Add Bus Decode in the Label menu or right-click on the label field to show the dialog 

below.  
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HAMEG DSO can set Stack Delay only. 

 

Record Length 

It’s for TravelScope to select the record length. 
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Set more parameters like Bus Name (DSO), Color (White), Parameter (DSO), and check 

Display the waveforms with decode, then click Advance to show the DSO Stack Settings 

dialog below.  

 

User can also click “Create Bus (Signal) Wizard” to add many DSO channels at one time. 
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DSO Stack Settings 

Channel 

Select the number of the DSO channels. 

Parameter 

Volt/Div 

Set the threshold voltages according to the working voltages of the target system. If the range 

of the measuring voltage is 1V, then set the amplitude of each grid as 1V. 1V/Div means one 

grid is 1V, and 2V/Div means one grid is 2V. 

x1 Probe/x10 Probe 

Only available for the Acute DSO. 

AC Coupling 

If checked, the coupling is AC or the default is DC. 

20MHz Bandwidth limit 

If checked, the 20MHz filter is enabled for the DSO. 

Connect CH1 and CH2 of the DSO with CH-00 and CH-01 of the logic analyzer respectively. 
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Move the mouse cursor on the left edge of the Waveform Window to adjust the waveform 

height; move the mouse wheel on the right edge of the Waveform Window to adjust the 

voltage per division (V/Div). 

Display the voltage 

Put the cursor on the left side of the waveform and left-click to drag the voltage amplitude 

vertically.  This will display the VPP, Vhigh, and Vlow on the right side of the waveform. 

The following figure is an example of 1MHz, 8 bits counter measured by the logic analyzer 

stacked with the DSO. 

 

 

Set the DSO as the Master and the logic analyzer as the Slave. 

In order to set the DSO as the Master, you also need to set the rising edge/falling edge as the 

trigger condition in the External Trigger dialog window below. Click the Hardware Setting to 

find the External Trigger dialog. 

 

How to stack with the Tektronix TDS5000B/DPO7000(Windows-based) 

Set the VXI-11 Server control on the right-bottom of the Windows as Start VXI-11 Server. 
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Use the crossover cable (Ethernet) to connect the logic analyzer (recommended). 

Open the TekVisa Resource manager\ Instrument manager to find the instrument list to show 

TCP/IP::192.168.1.114::INSTR. 

 

 

HAMEG Software Installation: 

Please download NI-VISA 5.4 software from NATIONAL INSTRUMENTS and install it. 

Please install USB driver if you select USB interface. Device Manager will show the 

following result when you install it completely. 

 

Because of connection HAMEG HMO3000 series DSO with PC by virtual COM port, we 
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click HAMEG HO730 USB with right button of mouse and select Content=>Advanced to 

check the Load VCP.  
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Virtual Waveform Generator 

The Virtual Waveform Generator ( ) can create a virtual waveform when (and must) there 

is no logic analyzer connected to your PC (Demo mode). 
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Tools 

 

Fonts 

Set font type and size for the Label field, Channel field, Value field, Status field, Waveform 

Window, Report Window, or State Window in the dialog box below.  

 

 

System Environments 

Customize the working environments in the System Environments dialog box below. 

 

Language 
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The LA Viewer supports English, Traditional Chinese and Simplified Chinese. 

Work Directory 

Set the file directory. 

Background color of the Waveform Window 

Set the background color of the Waveform Window. 

Grid line color 

Set the color of the grid lines in the Waveform Window. 

Grid line shape 

Set the shape of the grid lines in the Waveform Window. 

Grid size 

Set the size (in pixels) of the grid lines. 

The waveform height 

Set the waveform height (16~100 pixels). 

Tracking Cursor 

Change the tracking cursor default is Cursor E. 

Unit in the Report Window 

Display the waveform values in Sample or Timestamp in the Report Window. 

   

Display grid lines in the Report Window 

Display grid lines in the Report Window. 

Report track with waveform. 

Rounded to X decimal places 

Round the waveform values to X (0-9) decimal places. 

X ms refresh rate for Activity 
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Set the refresh rate (100~1000 mini-second) for the Activity field (state and frequency). (This 

feature is only available in TravelLogic Series.). 

Enable warning message 

A warning message will show if any system error occurs. 

Cursor snap to transition 

The cursor will snap (if close) to a transitional edge. 

Beep when trigger succeeds 

Beep when a trigger occurs. 

Show the timing / frequency in the Waveform Window 

Show the timing of the waveforms’ logic levels on the Waveform Window but not available 

for the group channels (bus). 

Show the logic state of the waveform when off the timing information. 

  

Beep when the memory buffer is full 

Beep when the memory buffer is full. 

Shade Alternate Channels 

Use two different colors for alternate rows to better differentiate the waveforms. 

Flick the waveforms 

Flick the waveforms. 

Load Last Project 

Load the last working environments (project). 
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Save waveform after each acquisition 

Save waveforms after each acquisition. 

Ask before exit the LA Viewer 

Ask before exit the LA Viewer. 

Check software update when starts the LA Viewer 

Check if there is a new version software each time when start the LA Viewer. 

Automatically enable bus decode report window 

Always show bus decode report window. 

Stop repeat capturing to show the last captured waveform 

Show the last complete waveform when stop repeat capturing. 

Scroll the mouse wheel to pan the waveform 

Pan the waveform by the mouse wheel. Zoom in/out the waveform by “Ctrl + 

mouse wheel”. 

Don’t show logic state of channel 

Do not show the logic state in the waveform. 

Show the channel transitional period in report 

Show the pulse width in the waveform. 

Show the frequency in the Waveform window 

Show the pulse frequency in the low state. 
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Toolbar Buttons 

 

Add/Remove 

Add/remove toolbar buttons to/from Toolbar in the dialog box above. 

Move Up/Move Down 

Move the selected buttons, shown on the Toolbar, up or down in the dialog box above. 
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Help 

 

 

 

Contents 

Open the software online manual.  

Update 

Update the latest version LA Viewer. 

Acute Home Page 

Link to our home page - www.acute.com.tw. 

FAQ 

Link to the frequently asked questions on our home page. 

Release Note 

Link to the release note on our website. 

About LA Viewer 

Show the current software version. 

 

 

http://www.acute.com.tw/
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Chapter 4  Digital Data Logger 
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How to use Digital Data Logger? 

 

Use time 

This feature is only available in TravelLogic Series.  

 

Start the Digital Data Logger 

It is able to record the acquired data for a long time as a log file xxx.log and independent of 

the LA Viewer. To use the record model only to record the transitional data (rising or falling 

edge), therefore, the overall amount of data transmitted will decrease because the data don’t 

change. 

 

You can find and click the Data Logger icon ( ) in the programs (Start\All 

Programs\Acute Logic Analyzer\Digital Data Logger) of your PC to show the dialog box 

below. 

 

File 

Enter the file name. 

Sample Rate 

In "Hz", can be an integer or decimal number. The maximum value is 50MHz. 



  

 102 Acute Technology Inc. Copyright 2016 

Channel 

The number of channels recorded. 

Stop after 

Stop Data Logger after the time (in seconds). 

Time 

The time (in seconds) being running Data Logger. 

Numerical Bases 

Save the data in Hexadecimal or Binary data type. 

Note: The logged file may lose some data if the sampling rate is high and will mark in the file. 

If this occurs, the program will place in the data leakage, marked “Lose data”. 

Threshold Setting 

 

You may also set the threshold for the data logger. 

Format Convert 

 

An example of the acquired data, consisting of Information (sampling rate and format in 

green box), Time (in decimal number when the edge changes in red box) and Data (in 

hexadecimal number in blue box), is shown below. The first data recording time is not 

necessarily 0, because the internal counter will start from power after the count. Therefore, it 
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is normal. If it is found much record time interval, because data did not change, so do not 

record data, this is normal. 

The sampling rate is 1000Hz, 0000000000026 in the red box denotes the edge changes at 

26/1000th second and 00003FFFF in the blue box denotes the data value for 36 channels at 

26/1000th second. Bit 0 of data for the channel 0. 
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Chapter 5 Miscellaneous 
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Release Note 

Release Note 

 

 

http://www.acute.com.tw/Software/ReleaseNote/ReleaseNote_LA.html
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Notes 

Hardware: 

1. Make sure that you use the USB cable in the product package. The device may be not 

available with other USB cable due to the poor quality of transmission. 

2. Always connect the logic analyzer’s ground lines to the target system in order to improve 

the measurement quality. 

Software: 

1. You can run several LA Viewer programs at the same time and if your PC has enough 

memory, but the second to open the LA Viewer will only demo mode. 

2. You can add multiple labels with the same channel but all labels only have one trigger 

condition. 

 

LA2000P series 

1. Do NOT connect the LA2164P’s printer round cable to the LA 2000P and the printer at the 

same time. 

2. If you use the PCI interface for the LA2164P, insert the LA mainframe into the PC’s 

lowest disk slot, so the cables will not interfere with the PC’s CD-ROM drive. 

3. If you use the external trigger for the LA2164P, connect the RG-58A/U (50 Ohm) coaxial 

cable with a BNC connector to the LA. 

4. The USB to Printer Port Adapter Cable in the product package can only be purchased from 

us if you have the demand. Other general adapter would not be available due to the special 

design of our adapter. 

5. Connect the LA2164P’s four pods (pod A, B, C and D) to its four ports (port A, B, C and 

D) in their respectively alphabetic order unless you want to check the function of each pod. 
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Connect the probe’s ground to the earth ground ONLY, NOT an elevated voltage. Please 

refer to the two figures in the next page. 

Prohibition 1: Wrong connection of TravelLogic’s ground. 

 

Prohibition 2: Electric potential A and B are not equal. 
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Tips 

Search Next Click Search Pattern on Toolbar, set search patterns and click Search, then 

move Cursor B to the trigger cursor position and click Search Next Pattern button. 

Use Create Bus (Signal) to set parameters for group channels or bus. 

The LA2164P model has 64 channels; but ONLY 32 channels (CH 0 ~ CH 31) support 

200MHz sample rate, so connect these channels to those signals that are 200MHz from the 

target system. 

Press A-Z key on the keyboard move the selected (key) cursor to the middle of the Waveform 

Window. 
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Questions 

Check the FAQ on our web site at www.acute.com.tw. We also provide tutorial videos on 

Youtube: www.youtube.com/user/AcuteTechnologyInc.  

http://www.acute.com.tw/
http://www.youtube.com/user/AcuteTechnologyInc
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Troubleshooting 

 

Hardware 

If the LA Viewer shows "Enter DEMO Mode" when the logic analyzer is connected to your 

PC, please check the following steps. Please contact your local dealer or us if the LA Viewer 

still does not work.  

USB interface (for the TravelLogic series, PkLA1616+ and LA2164P). 

Use the original USB cable. 

Check the USB interface/power connection. 

Check if there is an USB driver in the Device Manager and then download and install the 

latest version from www.acute.com.tw.. 

Run the LA Viewer again. 

Printer port interface (for the LA2164P). 

Check the power connection. 

Check the interface cable connection. 

Check if the BIOS is in any EPP mode as the table below. 

Run the LA Viewer again. 

PCI Interface (for the LA2164P). 

Check the power connection. 

Check the PCI card seating. 

Check the interface cable connection. 

Check if there is a PCI driver in the Device Manager and then download and install the latest 

version (if any, uninstall the previous version first) of the LA Viewer from 

www.acute.com.tw. 

Reboot the Windows OS. Run the LA Viewer again. 

 

http://www.acute.com.tw/
http://www.acute.com.tw/
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Logic Analyzer Manual  

Copyright


2016 Acute Technology Inc. All Rights Reserved. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Acute Technology Inc. 

www.acute.com.tw 

Address：6F-7, #12, Ln. 609, Sec. 5, Chongxin Rd., Sanchong Dist.,  

New Taipei City 24159, Taiwan 

Tel：+886-2-2999-3275 

Fax：+886-2-2999-3276 

E-mail: service@acute.com.tw 

http://www.acute.com.tw/
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